The science of fluid flow has numerous applications. For centuries, mankind has been analyzing fluid behavior and designing instruments that control and harness the power of a moving fluid. Inventions as diverse as sailing rafts, water wheels, water clocks, sea walls, dykes and steam engines all represent earlier efforts to gain control over fluid flow.

Thus the analysis of fluid flow is the first step to understanding fluid behavior, which in turn leads to better and more efficient design of devices. Fluid flow problems for modern day machines such as turbines, cars and planes are intensively researched during the design phase. Building prototypes and testing them under controlled conditions such as inside a wind tunnel is not only time consuming but also expensive. In many cases, the size of a product renders physical testing impractical.

A theoretical / mathematical approach for solving fluid flow has its own limitations. The highly non-linear nature of the flow governing equations yields only a handful of exact solutions. In light of this, numerical techniques have evolved and flourished with the advent of computer technology. CFD (Computational Fluid Dynamics) is the branch of flow simulation where numerical techniques are used in conjunction with the computational power of modern computers to solve a variety of flow problems. CFD is the predominant means of analyzing fluid flow problems today.
Important Note on Archived Datasets

The datasets associated with each module in Section 5 have been Archived to facilitate downloading. An Archived dataset is a compressed file created by Autodesk Simulation Multiphysics to reduce the overall size of the file. The Archived files do not contain solution results, and it will be necessary to execute the analysis in order to obtain the results.

Note that Modules 1 and 2 do not require datasets.

An Archived dataset can be retrieved by selecting the Autodesk Simulation Icon in the upper left corner of the screen, selecting “Archive” in the drop down menu, and then selecting “Retrieve.”
## Table of Contents

*Click below to jump to the current Module:*

1. Module 1: Overview of Fluid Flow ................................................................. 4
2. **Module 2: Numerical Methods** ................................................................. 4
4. Module 4: Steady State (Couette Flow) ...................................................... 9
5. Module 5: Unsteady Flow (Von Karman Street) ....................................... 13
1. Module 1: Overview of Fluid Flow

In this section we will primarily focus on two real life examples to learn the basics of fluid flow theory and learn how numerical methods can be applied to solve such problems.

The first example involves flow between two parallel flat plates. The top plate is moving at a constant horizontal velocity while the bottom plate is fixed. This problem is commonly known as Couette flow. The industrial application of such flow can be seen in bearings where the lubricant flows between two concentric bearing cylinders. Once the flow is established, fluid characteristics at any given point in the fluid domain do not change with time, hence this case will be considered as steady state flow. Fluid flows between two parallel plates in parallel layers such as this case is categorized as an example of an internal and laminar flow.

The second example is flow across a cylinder. At low Reynolds numbers, the flow can be considered as steady. The Reynolds number is defined as ratio of inertial forces to viscous forces in a fluid\(^1\). An interesting phenomenon is observed at flow across bluff objects where the Reynolds numbers is high. In this case, repeated swirling vortices are created downstream of the bluff body. This phenomenon is known as Von Karman Vortex Street. As the flow characteristics at any given point in the fluid change over time, this is one of the simplest and yet most intriguing examples of unsteady fluid flow. Due to vortices created downstream, the flow has significant turbulent effects as well.

2. Module 2: Numerical Methods

We will go through different concepts of fluid flow numerical modeling with these two examples in parallel. For each problem we’ll go through the phases of preprocessing, solution and post-processing. During preprocessing we’ll learn domain modeling, domain discretization (commonly known as meshing), boundary condition applications, and application of material properties. Solutions will include verifying the selected analysis type and parameters, followed by launching of the calculation process. During post-processing we will see how to visualize and interpret results.

Note that for all modules in this section, incompressible flow conditions are assumed. Incompressible flow covers the majority of real-world problems and can be simulated using Autodesk Simulation Multiphysics. Autodesk Simulation CFD is capable of handling both compressible and incompressible flow simulation and should be used in cases where compressible flow conditions are anticipated.

\(\text{Reynolds Number} = \frac{UL}{v}\)

Where: \(U\) is the fluid velocity; \(L\) is the characteristic length, and \(v\) is the kinematic viscosity
3. Module 3: Preparing a Numerical Model (Couette Flow)

Introduction

During this section we will prepare the model to simulate flow between two parallel plates. The flow pattern for this case will be purely in a single plane (velocity variation perpendicular to the flow direction only) thus we can consider a 2D modeling approach.

It is important to emphasize that before starting a simulation for any real life problem, assumptions and simplifications are made for numerical modeling. Appropriate simplifications greatly reduce the user input and the computational effort and can still yield a high level of accuracy. On occasions, simplification can also lead to greater insight by isolating the phenomena of interest. In other cases, simplification can be made to remove small flow disturbances to focus on the wider picture. Thus simplification can be made for both macro and micro level studies. The most fundamental assumption for fluid flow is to solve a problem in 2D to avoid an exercise in 3D, which can take much longer to solve. 2D flow is a reasonable assumption if the flow behavior is either completely unchanging or negligibly changing in any one of the three dimensions. A weather system such as the path of a hurricane is an example of 2D modeling. However, caution should be exercised when making geometry simplifications or reductions to 2D models, as over-simplification can lead to incorrect modeling and yield false results. Another useful simplification is symmetry. If flow can be identified as symmetrical about an axis, the domain size required can be halved or even quartered, greatly reducing the domain size and computation time.

Preprocessing

Preprocessing is the first step of any numerical analysis where the user defines a mathematical representation of a physical problem. It consists of defining and discretizing the domain, defining the attributes and applying boundary conditions.

We will start by creating a rectangle with a height equal to the separation between two plates and a length to represent the fluid domain. We will then mesh this rectangle. These steps will cover the domain modeling and its discretization.

Once we have completed the model, we will apply boundary conditions. For the first simulation, the bottom plate is considered as fixed, so that all bottom nodes that represent

Figure above illustrates the reduction of domain by identifying axis of symmetry
the very first layer of fluid molecules in contact with the solid wall are defined with zero velocity. The top surface will be in contact with a moving plate. Using a “no-slip” assumption, the top layer molecules will be travelling at the same velocity as the upper plate.

**Execution**

1) **LAUNCH THE SOFTWARE AND CREATE A NEW FLUID FLOW ANALYSIS FILE**
   a) Launch Autodesk Simulation Multiphysics and click on the “New file” button. On the “New” file dialog box, change the analysis type to: Fluid Flow>Steady Fluid Flow
   b) Make sure that the unit system is set to custom units based on SI but with length in mm
   Tip: Select SI units first and then change to “Custom” and change length to mm
   c) Clicking on the “New” button opens the “Save as…” dialog box where the user can define the working directory and name of the file to be saved. Enter “Steady State Couette Flow” as the file name and click “Save”. A new empty file is created with the “FEA Editor” environment ready for model preparation. At this point the user can start defining the geometry for analysis.

![Image of Autodesk Simulation Multiphysics interface]

2) **DEFINE THE FLUID DOMAIN**

The relevant fluid domain is the fluid volume between the two parallel plates. This will be a cuboid in 3D. However, as discussed earlier, as there is no gradient along the depth of the model, we can consider this as a 2D problem where velocity is perpendicular to the plates. Autodesk Simulation supports 2D models to achieve a solution in less time than an equivalent 3D model

Tip: 2D models must lie on YZ plane for analyses

We will sketch a rectangle of 500mm length and 100mm height that represents the fluid domain. We’ll then use that rectangle to generate a structured mesh. Automatic 2D meshing feature can also be used to mesh a sketched profile as well, however for simple rectangular geometries like this it is easier and faster to use “4 point Rectangular mesh” to get a structured mesh.

a) Under “Planes” branch select “Plane 2 <YZ (+X)>” branch and select “Sketch” from the right click contextual menu.

b) On the Ribbon go to the “Draw” tab and then click on “Rectangle”
c) Ensure that “Use as construction” is checked and then click “Enter” to accept the starting point of the rectangle at (0,0,0); Enter X=0; Y=500 and Z=100 and again click “Enter”; click on “Apply” and then close the dialog box using the top right button on the window.
d) Go to “View” tab and click on “Enclose (Fit All)” for zoom to fit.

Note that as soon as the user clicks on “Apply” a new part “Part 1” is created and added to the Parts list in the “Navigation tree” or browser. This part contains only the rectangle as the construction object at this time.

3) **Discretize the Fluid Domain**

At this stage we have modeled the fluid domain geometry as a simple 2D rectangle composed of straight line construction objects. The construction objects forming the rectangle are available under the last sub branch of Part 1 within the Navigation Tree. We can mesh the rectangle by a right click on the construction object branch under Part 1. This will create an automatic mesh attached to the geometry, however it might be unstructured. For simple geometries Autodesk Simulation has straightforward tools that discretize (divide) simple shapes with a Structured Mesh. We will use one of those tools in our case. The rectangle will be used only to graphically pick reference points to create a rectangular mesh which will not be associated with the geometry. An alternative method would be to enter the coordinates of the rectangle in which case no existing geometry is required. We will define 10 mesh divisions along the height and 50 mesh divisions along the length. Note that this method does not create a mesh associative with the geometry. However a “4 Point Mesh 1” object will be added under the “Meshes” branch. This can be used to modify the parameters of the mesh at any time.

a) On the “Mesh” tab select “4 Point Rectangular” from the “Structured Mesh” panel; Enter AB=10 and BC=50
b) Carefully select the four points A, B, C, D by starting from the lower left corner of the rectangle and continuing in a clockwise manner as shown in the figure on the right; click “Apply” to generate the mesh
c) Close the window
d) Turn the visibility of Plane 2 off by unchecking visibility from the contextual menu

4) **Define the Attributes**

At this point, the fluid domain is discretized. As can be seen in the browser some information is still missing as highlighted in red. Undefined information includes the
Section 5: Fluid Flow

element type, element definition and material.

As we are looking at a problem that can be reduced to a 2D domain, the 2D elements available to us are 2D Planar and 2D Axisymmetric. Since the problem being investigated is not axisymmetric, 2D Planar elements will be used. These elements are useful for flow situations where the flow remains unchanged along the depth axis (into the screen). Note that axisymmetric flow has radial symmetry about a central axis. Flow inside a pipe is an example of axisymmetric flow.

The user can define the viscosity model to be used. We will use water as the fluid and use the default Newtonian viscosity model. In this case, the element type is 2D and the material is selected as Water. In the material library, “Water” is characterized with dynamic viscosity and mass density.

a) Right click on the “Element Type” branch under Part 1 and select “2-D Planar”
b) Right click on the “Material” branch under Part 1 and click on “Edit Material…”
c) From the library select “Water” under the Liquid group and click “OK”

At this stage, the user can either opt to continue to the next section with the current analysis or save the file and exit the software to resume the analysis later. The file can be saved as “Steady State Couette Flow-Applying Boundary Conditions.fem”. 
4. Module 4: Steady State (Couette Flow)

Introduction

Couette flow refers to laminar flow of a viscous fluid between two parallel plates, where generally the bottom plate is stationary while the top plate moves at a constant speed. As there is no time dependent effect (there are no points in the fluid where flow characteristics vary with time), the flow can be considered Steady State.

We will model the same conditions on our rectangular mesh. This can be achieved by imposing velocity boundary conditions on the top and bottom of the rectangle. The fluid will enter from the left side and exit the domain from the right. This can be defined by imposing Inlet/Outlet conditions that assume a near zero pressure differential. Note that the mesh is independent of the geometry due to the method used for mesh creation. For this reason, we will need to select nodes to impose velocity and inlet/outlet boundary conditions.

Execution

1) APPLY BOUNDARY CONDITIONS

Open the file saved earlier as “Steady State Couette Flow-Applying Boundary Conditions.fem” or continue with the file from the previous section.

Model the Top Moving Plate
A “no slip” condition is assumed, so that the fluid particles adjacent to the top plate will move with the same velocity as the moving plate along the horizontal (Y) axis. We will assume that the top plate moves at 1 mm/s for this exercise, and then apply the same velocity to the top line of nodes.

a) From the Quick Selection toolbar, activate the “Rectangle Select” and “Select Vertices” tools
b) Draw a rectangle to select all top nodes of the rectangle; right click > “Add” > “Nodal Prescribed Velocities…”

Activate Y and Z magnitudes by checking the corresponding boxes; enter 1 in Y-Magnitude and click OK to apply the velocity

Define Inlet/Outlet
To allow fluid flow across the domain we need to define the inlet and outlet by imposing inlet/outlet conditions. In Autodesk Simulation Multiphysics, there is a single boundary condition called the inlet/outlet condition.

Flow will be induced based on the imposed velocity conditions in conjunction with the inlet/outlet condition. In our case the nodes on the right and left hand side of the rectangle will be defined as inlet/outlet conditions.

d) With the current selection tools (rectangle and vertices select), draw a rectangle to enclose all the nodes on the left edge of the rectangle except the top and bottom nodes which will have velocity boundary conditions

e) While holding down the Ctrl button, select the nodes on the right end of the rectangle except for the topmost and bottom node
f) Right click > "Add" > "Nodal Prescribed Inlet/Outlets…"

To impose a horizontal motion to the same set of nodes we will impose a velocity of zero in the Z direction.

g) Right click > "Add" > "Nodal Prescribed Velocity"; activate Z-Magnitude and click OK

Model the Bottom Stationary Plate
The bottom nodes will also be in immediate contact with the bottom stationary plate, which is modeled by imposing a zero velocity condition. All outer nodes that are not defined with a given velocity or inlet/outlet default to a velocity component of zero, therefore we do not need to do anything else to set up the proper condition.

2) **SET UP AND LAUNCH THE ANALYSIS**

At this point the model definition is complete. However, the “Analysis Type <Steady Fluid Flow>” branch in the navigation tree is displayed in red, which indicates that the branch needs attention. By double-clicking on this branch we can confirm the analysis parameters.

![Analysis Parameters - Steady Fluid Flow](image)

**Pseudo-Time(s):** Acts as a counter, as time has no physical meaning in a steady fluid flow
**Multiplier:** Controls the variation of input values over pseudo-time.
**Steps:** defines the number of steps to reach the multiplier value
Following are the steps to verify the analysis parameters and launch the analysis.

a) Double-click on "Analysis Type <Steady Fluid Flow>"
b) Verify the parameters and click on "OK" to accept
c) Under the "Analysis" tab, click on "Run Simulation" to launch the analysis

As soon as the calculation process begins, the software shows the analysis log echoing different phases of analysis that indicate the convergence status and analysis progress.

3) POST-PROCESSING

As soon as the first set of results are available, they are displayed in the “Results” environment. As the name indicates, the “Result” environment is used to display results in different forms, such as color contour, graph or list format. For any editing of the analysis, the user will have to switch back to the “FEA Editor”.

By default, velocity magnitude results are displayed along with Loads and Constraints symbols, which can be hidden using the “View” tab. The velocity magnitude display shows the linear variation of velocity contour from zero on the bottom to a maximum velocity of 1mm/s on the top. Following the steps below, we will plot velocity results using two different methods to confirm that the velocity is linearly changing along the vertical direction.

a) Activate “Rectangle Select” and “Vertex Select” from the Quick Access Toolbar
b) Select a vertical column of nodes by drawing a rectangle so that only a single vertical column of nodes is selected in the middle of the fluid domain

This will create a graph embedded into the current window that shows a plot of velocity magnitude vs. the node distances. In the browser under the “Presentations”->"1<Velocity Magnitude>"->"Embedded Presentations” branch, a new item is added that corresponds to this embedded plot. The embedded plot can be managed or deleted using this item.
Next we will display the Velocity Y- component and then the velocity vectors plot.

d) From the “Result Contours” tab under the “Velocity” drop down menu, select “Y Direction” velocity magnitude

This displays the Y Direction component of the velocity vector contour, which identical to the Magnitude contour as the flow is purely in the Y direction.

e) From the same Velocity drop down, select “Vector Plot”

This displays the velocity vector plot with arrows in the direction of the velocity and scaled to the magnitude. The linear variation of velocity from bottom to top can be noticed once again from this vector plot.
5. Module 5: Unsteady Flow (Von Karman Street)

Introduction

Unsteady flow refers to a condition where the fluid flow changes over time at one or more points in the system. A very common and interesting case of unsteady fluid flow is flow past an obstacle. If the Reynolds number falls within a specific range, flow over an obstacle creates disturbances that result in characteristic repeating patterns in the flow wake. Similarly, trickle flow coming out of a reservoir tank is unsteady just before it empties.

This pattern of alternating vortices is caused by the unsteady separation of flow over a bluff body, hence this condition can be only handled with an unsteady flow analysis. This phenomenon can be easily observed behind a pier of a river bridge where eddies appear in the downstream wake and are carried away by the stream. Other examples include wind blowing across an obstacle such as a flag pole or an industrial chimney. In fluid dynamics, this phenomenon is known as Von Karman vortex street.

When a vortex is shed, an asymmetrical flow pattern forms around the body, which therefore changes the pressure distribution. This means that the alternate shedding of vortices can create periodic lateral forces on the body in question, causing it to vibrate. If the vortex shedding frequency is similar to the natural frequency of a body or structure, it causes resonance.

This wake might be complex depending on the shape of the obstacle. In order to understand this phenomenon and see how we can simulate it, let’s consider a simple case: a two-dimensional flow past a circular cylinder. This case illustrates Strouhal instability and the particular wake as discussed above i.e. Von Karman Vortex Street. It is a succession of eddies created close to the cylinder that break away alternatively from both sides of the cylinder. Vortices are emitted regularly and rotate in opposite directions.

We’ll consider a circular obstruction of an industrial chimney of two meters radius standing in a wind blowing at 3m/s. Given that the flow is perpendicular to the axis of cylinder and the cylinder is uniform, we can simplify this as a two-dimensional case. The dimensions of the fluid domain around the circle that we’ll consider are shown in the following diagram.
Section 5: Fluid Flow

**Execution**

1) Launch Autodesk Simulation Multiphysics & Start a New Unsteady Flow Analysis
   a) Launch “Autodesk Simulation Multiphysics”
   b) On the “Getting Started” tab in the “Launch” panel click on the “New” button
   c) From Choose analysis type, select “Fluid Flow” > “Unsteady Fluid Flow”
   d) Click on “Override Default Units…”
   e) Select “Metric mks (SI)” from “Unit System” and click OK
   f) Click on the “New” button to create a new file with “Unsteady Fluid Flow Vortex Shedding” as the file name and click “Save”
   g) This will create a new empty file with unsteady fluid flow as analysis type and put the user in FEA Editor environment to start defining the model

2) Define the Fluid Domain

   The fluid domain is defined by creating a simple sketch of the circle enclosed by a rectangular box. We will place the circle close to the entry and leave a sufficiently large length downstream to capture the vortex shedding. For external flow cases such as this, defining the domain size can be difficult. It depends upon several parameters, and in particular the Reynolds number which determines the region of influence. For external flow, a balance has to be reached. If the region of influence is set larger than needed, the result is excessive computational requirements. If the domain is too small, the region of influence may not be fully captured and can result in mass and momentum imbalance, and convergence may be difficult to achieve. Defining the optimal domain size comes with experience, although a few rules of thumb are available based on hydraulic diameter to make reasonable initial estimates. As this case will be modeled in 2D, it is important to select the YZ plane as the sketch plane.

   a) Under the “Planes” branch, select the “Plane 2 < YZ (+X) >” branch and select “Sketch” from the right click contextual menu
   b) On the Ribbon go to “Draw” tab and then click on “Rectangle”
   c) With “Use as construction” checked enter X=0; Y=-10 and Z=-12, and click “Enter” to accept the starting point of the rectangle at (0,-10,-12)
   d) Enter X=0; Y=50 and Z=12 and again click “Enter”; click on “Apply” and then close the dialog box using the top right button on the window
   e) Go to the “View” tab and click on “Enclose (Fit All)” to zoom the window to fit
   f) To create the circular obstruction, click on the “Circle (by diameter points)” icon
   g) Enter Y=2 and click Enter to define the 1st diameter point at (0,2,0)
h) Enter \( Y = -2 \) and click Enter to define the 2nd diameter point at \((0, -2, 0)\); click on “Apply” and then close the dialog box using the top right button on the window
i) Turn the visibility of Plane 2 off by unchecking visibility from the contextual menu

3) Define the Attributes

The fluid domain is now modeled as a 2D sketch. At this point we must discretize the domain and then define the attributes – the order of these actions is unimportant. In this case, we will first define the attributes.

a) Select the “Element Type” branch under “Part 1” main branch
b) Right click and select “2-D Planar” element
c) Right click on “Material” sub branch and click on “Edit Material…”
d) From the “Gas” folder of “Autodesk Simulation Material Library” select “Air”
e) Click Enter to apply the material and close the dialog box

4) Discretize the Fluid Domain

Now we will proceed to discretize the domain. As the velocity gradient around and behind the circle in wake will be high, we’ll pay particular attention to have a sufficiently refined mesh in these areas.

a) Right click on the last branch “1<YZ(+X)>” of the Part 1 that contains the construction objects and click on “Create 2D Mesh…”
b) Enter the mesh parameters as shown below in the “2D Mesh Generation” dialog box and click “Apply”
   i) Mesh size = 0.4 defines average mesh size for the discretization
   ii) Angle=5° defines one division each 5° for curves, this will refine the mesh around the circle
   iii) Geometric Ratio=1.15 defines a 15% increase in mesh size for mesh transition from smaller to larger elements. A sudden increase in mesh size can lead to numerical errors, hence a gradual transition to larger elements is preferred. In most cases a Geometric Ratio less than or equal to 20% is appropriate.

To locally refine the mesh we can define “Refinement points” at selected points in
Section 5: Fluid Flow

the domain. In this case we want to refine the mesh in the immediate wake of the cylinder to better model the vortex separation.

c) With the “Point Select” and “Select Vertices” tool select two points behind the circle separated from each other and from the circle by a distance approximately equal to the diameter of the circle. Right click >“Add”>“Refinement Points…” to define the mesh parameters for the refined mesh in the wake of the obstacle.

d) In the “Refinement Points” dialog box enter Effective Radius=2m; Mesh Size=0.4m; click Enter

e) To update the mesh with mesh refinement right click on the Construction object branch of Part 1 >“Edit 2D Mesh…” (like in step 1) and click “Apply”

5) Apply Boundary Conditions

Now it is necessary to define boundary conditions for our model. We will consider air entering from the left side and exiting from the right side of the fluid domain. The top and bottom edges will be assumed to be “far field” zones.

**Entrance Condition**

We will model the air entering from the left with gradually increasing velocity to model the effect of increasing Reynolds number and for better convergence and then maintain the velocity to analyze the phenomenon. We will ramp up inlet velocity from 0 to 3m/s during the first 5 seconds and then maintain this velocity for the next 55 seconds.

a) From the top “Quick Access Toolbar” choose “Select Edges”
b) Select the left vertical edge of the rectangle by clicking on it
c) Right click > “Add” > “Edge Prescribed Velocity”
d) Check activate Y Magnitude and Z Magnitude fields
e) Enter Y Magnitude = 3 m/s
f) Click on the “Curve” button
g) Click on the “Add Row” button twice
h) Fill the table as shown on the right
i) Click “OK” twice to close both windows
Far Field Condition
The top and bottom edges represent far field zones. This means that the domain is large enough to have no or negligible flow disturbance at these edges due to the presence of the obstruction in the domain. We will impose this condition by defining a zero velocity across the edges (that is no fluid flow perpendicular to the boundaries). Obviously, it is necessary to define a domain large enough so that the “Far Field” condition can be appropriately applied.

j) Select the top and bottom horizontal edges of the rectangle
k) Right click>"Add">"Edge Prescribed Velocities…”
l) Check Z Magnitude=0
m) Click “OK”

Exit Condition
We will impose an exit condition by defining an Inlet/Outlet on the nodes of the right vertical edge of the domain. This will complete the definition of boundary conditions for our case.

n) Select the left vertical edge
o) Right click > "Select Subentities">"Vertices" (Edges don’t support Inlet/outlet condition)
p) Right click > "Nodal Prescribed Inlet/Outlets…”

6) Set up and Launch the Analysis

Now that we have the definition of the model completed, we will establish analysis parameters and launch the analysis.

a) Double click on “Analysis Type <Unsteady Fluid Flow>”
b) In the 2nd and 3rd rows of Steps column enter 10 and 550 respectively
c) In the 2nd and 3rd rows of Turbulence column enter “1” to activate turbulence modeling
d) Click on “OK”
e) Go to “Analysis” tab and click “Run Simulation”

7) Post-Processing

As soon as the first sets of results are available, they are displayed in the “Results” environment. Depending upon the computational resources available, this analysis may take some time to finish. We assume that the user will allow sufficient time for the analysis to complete before starting post-processing, although post-processing can be started as soon as the first set of results are available.

This example focuses on reporting and displaying the fluid velocity results from the simulation, including velocity streamlines and particle paths. In addition, other useful information can be obtained from the simulation and displayed, such as the distribution of fluid pressure.
Section 5: Fluid Flow

Displaying Velocity Results Over Time and Saving Animation:
At the end of the analysis the default display shows Fluid Nodal Velocity of the last sub-step at 60s along with applied loads and boundary conditions.

In an unsteady state analysis, results of each sub-step are saved as a set known as a “Load case”. Hence the variation of flow over time can be analyzed by going through different “Load Cases” and even saved as an AVI.

Let’s start by making the contours clearer to visualize. By default, the legend is automatically adjusted for each frame to display red for maximum and blue for minimum values. Although setting these limits makes sense for any one individual frame, for animating results over time it is necessary to set a constant global maximum value to maintain constant color for a given velocity.

Note that although the maximum velocity is found to be 5.414 m/s we will set the maximum value as 4 m/s for the entire simulation. This will display all values greater than 4 m/s in red, which will allow for a better contrast of results less than 4 m/s, in turn showing vortices more clearly.

a) Go to the “View” tab and click on “Loads and Constraints” from “Appearance” panel to hide symbols
b) From the “Results Contours” tab, click on “Legend Properties” from the “Settings” panel; switch to the “Range Settings” tab
c) Uncheck “Automatically Calculate Value Range”; enter “4” as high value and click OK
d) Use the navigation tools on the “Load Case Options” panel to step along the time range to explore flow variation over sub-steps
e) Click on the “Start” animation button to animate the results over sub-steps in the graphical window
f) Click the “Animate” drop down button and click “Save as AVI”
g) Enter desired name for the avi and click on “Save”

Plotting Streamlines:
Streamlines are curves that are instantaneously tangent to the velocity vector of the flow. These curves show the direction a fluid element will travel in at any point in time. Multiple groups of streamlines can be added to the fluid. Each of the added group appears as a sub-branch under the “Flow Visualization” branch and can be activated, deleted and edited independently to change display properties.

We will add a group of streamlines to better understand the flow.

h) From the Quick Access Toolbar activate “Rectangle Select” & “Select Nodes”
i) Draw a rectangle to select a group of nodes at approximately mid 1/3rd of the left vertical line; right click > “Add Streamlines”
j) By clicking on the “Appearances” button the user can adjust the width as necessary.
Section 5: Fluid Flow

k) Close any open windows
l) The user can step through different load cases to see how the streamlines change
m) Right click on the “Streamline” sub branch under the “Flow Visualization” branch
n) Select “Delete” to delete the group

Plotting Particle Paths:
Let’s now add a group of massless particles in the fluid flow to trace their paths. This is similar to adding colored ink in a fluid stream or smoke in gas flow to better visualize the fluid flow. Make sure that “Rectangle Select” and “Select Nodes” is still active.

Note: Particles shown in the particle path have zero mass and therefore do not affect the simulation itself. Autodesk Simulation Multiphysics does not simulate the motion of actual smoke particles.

o) Draw a rectangle to select a group of nodes at approximately mid 1/3rd of the left vertical line, as previously done; right click > “Add Particle Paths”
p) Click on “Particle Path Settings”
   i) “Start time” defines the time at which the first set of particles will be injected through the selected node. We will leave it as 0.
   ii) Type “5” as “Time interval between introducing particles” to add a new set of particles to the selected set of nodes
   iii) Type “12” as “Number of particles to introduce” to add 12 set of particles; click “OK”

Back on “Particle Paths” click on “Appearance” to adjust the width of the particles if necessary

q) Close the dialog box
r) Use the load case navigation button to step back and forth in the simulation to visualize the movement of particles. The results can be automatically stepped through using the animation feature
s) From “Animate” drop down menu, select “Save As AVI”; enter an appropriate name and click “Save”
t) Right click the part “1” sub-branch under “Parts” main branch and uncheck “Draw Transparently”

Results are animated and each frame is saved in the AVI which can be then shared.

Displaying Vorticity Plot:
Another useful tool to highlight vortices is the vorticity display. This enables visualization of the clockwise and counterclockwise movement of the vortices. The following steps are used to display vorticity.
Section 5: Fluid Flow

u) Click on the “Vorticity” button on “Velocity and Flow” panel

Note that the “Particle Path” is still displayed and the part is semitransparent. Let’s delete the “Particle Path” and deactivate the transparency of the results.

v) Right click the “Particle Path” sub-branch under “Flow Visualization” and click on “Delete”
w) Click on “Last” load case button to display the last set of results

Note that only the positive values of the vorticity results are displayed and hence only one side of vortices are displayed. A quick glance on the legend at right shows that the values are still set to the previously entered values for velocity (0-4m/s) whereas the bottom Maximum and Minimum values show values around +30 and -30. To display the results with a higher contrast we’ll set the max. and min. values to +5 and -5 respectively.

x) From the “Legend Properties” drop down select “Setup”
y) Switch to “Range Settings” tab on “Plot Settings” dialog box; enter Low=-5 and High=5; click “OK”

Set back on forth using the Load case option to visualize how vortices are shed from each the top and bottom side of the cylinder with reversed vorticity.

z) Click on “Start” button 🎥 to automatically step through the results to see animation over time

With this animation we can clearly see that vortices are being shed at regular intervals although the flow is entering at a uniform velocity. The phenomenon of Von Karman Vortex street can be shown with unsteady fluid flow. This concludes our exercise.

8) Investigating “What-if” Scenarios

One of the main benefits of analyzing fluid flow through simulation software can be realized when investigating “What-if” scenarios. Various parameters can be changed to see the effects of fluid flow in different conditions. Hence every simulation setup acts as a template and by a few clicks and readjustments of parameters, new results are found and thus a far greater insight of flow behavior is gained that is not possible through other conventional tools of analysis. For instance the two examples presented in this document can be re-investigated with different values. In the Couette flow exercise, the viscosity, the plate velocity and thickness between the plates can be changed. Similarly for unsteady vortex shedding, the flow velocity can be changed and likewise the air viscosity. The change in thickness of the eddies with the increasing viscosity can be investigated.

9) Compressible and Incompressible Flow

It is important to note that although the material defined in the two exercises above were water and air respectively, the software treats them both as incompressible. This is because the setup for density variation was not changed by the user and by default the software assumes the density to be constant. If we need to change the density, we will
have to key in information for its variability. This can be an expression that is linked for instance to the fluid temperature such as Boussinesq approximation.

Autodesk Simulation Multiphysics is capable of simulating incompressible flow conditions, but not compressible flow. For compressible flow problems, Autodesk Simulation CFD should be used.

10) Flow through Porous Media and Open Channel Flow

Fluid flow through porous media has several applications, such as the flow of air across an air filter. In today’s world with extensive research being carried out on fuel cells and with the evolution of new materials (foams, textiles, papers, membranes), porous media research has gained even more importance.

Similarly, open channel flow is another branch in fluid mechanics that involves the flow having a free or an unbounded surface. Examples are flow in a stream, flow across a dam or flow in a conduit.

Simulation of fluid flow along/across porous medium can be incorporated in Autodesk Simulation Multiphysics, however flow through a porous media is a specialized area and is generally not taught at the undergraduate level. Likewise Open channel flow can be analyzed but only in 3D and solved for a transient solution. Thus for the sake of brevity of this document, details are not included herein.

The software solution is only as good as the user input. If the assumption and approximations are wrong, incorrect results can be expected from the software. Thus sound understanding of fluid mechanics theory coupled with the software operation is crucial for any successful simulation.